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RADIOPRO DISPATCH OVERVIEW

The IP Gateways interface the radio system to an IP network. One IP Gateway is required for each control station radio
used for voice. The IP Gateways and control station radios can be centrally located or scattered among different locations
using a Virtual Private Network (VPN) or Wide Area Network (WAN) such as the Internet.

Each IP Gateway in a RadioPro system acts as the server for the Control Station Radio connected to it, and ensures easy
wide-area deployment. Since there is not a server PC, the architecture reduces “single point-of-failure” concerns.

A system may have a mixture of RadioPro Dispatch, Solo, and Talk clients for PCs, as well as RadioPro Talk for Mobile
apps running on mobile devices. These Clients may be centrally located or scattered among different locations using a
Virtual Private Network (VPN) or Wide Area Network (WAN) such as the Internet.

RadioPro Dispatch offers a console-type solution for applications requiring connection to many NEXEDGE or
MOTOTRBO radios (control stations). It is designed with an intuitive user interface to minimize learning time and
maximize a user’s efficiency. A host of accessories are available to implement an enterprise solution; including desk
microphones, headsets, footswitches, and touch screens — all with PTT capabilities. Depending on the license purchased,
features of RadioPro Dispatch may include:

e Voice Dispatching for 1 to 40 Talk Groups
e GPS Mapping of radio subscriber units

e Text Messaging

e Voice and Event Logging and Playback

o Telemetry

Talk Group 1Y Talk Group ZY Talk Group SY Talk Group 39Y Talk Group 4OY
|

=:

LAN Switch _%-+
= -

Router/Firewall

RadioPro Dispatch ~ RadioPro Talk RadioPro Talk RadioPro RadioPro RadioPro Talk
(for Windows) (for Windows) (for Mobile iOS/Android) Dispatch Talk (for Mobile iOS/Android)

80 Clients max. per IP Gateway
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STARTUP

To start the RadioPro Dispatch client, double-click the RadioPro Dispatch icon on the PC desktop.

When the Login window is displayed as shown at right, choose a User from the [ Login ==
drop-down list, and then click the Login button.

User  Demo Dispatcher -

Legin

EXAMPLE CONFIGURATION

When the RadioPro Dispatch Client opens, the Main Window will be displayed with various tabbed panels:
e Radio Controllers (voice)
e Map
e  Subscribers
e Recent History
e Text Messaging
e  Geo-fence Alerts
e Missed Calls
These tabbed panels can be docked in alternate positions or hidden completely if not needed. The Main Window on the

PC monitor may look different than the example shown below, depending on how your System Administrator configured
the tabbed panels within the RadioPro Dispatch client user interface.

+
m
2
i€
@
A

Toolbar

o s ) (0] = o rr.

Analog MDC

Subscribers List —p & criDigial

Radio Controller ; 1o
Tabs for Voice s

i (Y f
e 238 g A Map Tabs

Recent History &
Geo-fence Alerts
Tabs

Text Messaging &
Missed Calls
Tabs
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TOOLBAR

The Toolbar contains tools for Audio levels, as well as standard and custom buttons as described below.

Audio Controls

Initial Settings

Use the audio sliders on the Toolbar to adjust audio levels for Mic transmit audio, Select
receive audio and Unselect receive audio. A VU meter is located next to the Mic audio
slider to visually determine the loudness of outgoing transmissions. Mic Select Unselect

Begin by selecting an Audio Preset from the Options Menu. Audio Presets may g
be configured by the System Administrator for various audio devices including speakers, | i orien [shon s
microphones, and headsets. A “default” preset uses the PCs default selection for

microphone and speakers. |

Make initial volume settings as follows: e o
. In the Toolbar, adjust the Mic and Select sliders to 100%, and the Unselect slider to 50%.

. In each Radio Controller, click on the speaker tool , and adjust the Public 1: Digital
slider to 100%.
. If desk speakers are installed for receive audio, use the control knob on

the desk speakers to adjust the overall speaker volume to 50%.

Mic Audio Transmit Slider and VU Meter

Various microphones and headsets may be connected to the Dispatch PC for transmitting audio. Only one active device
can be used at any given time, determined by the selection in Options .. . Audio Presets.

While clicking on a PTT button, speak into the microphone or headset and view the microphone audio level displayed on
the VU meter (located on the Toolbar next to the Mic slider). For optimum sound level, the meter should reach into the
yellow area 10-50% of the duration. The red area indicates clipping and distortion, and should be avoided. To adjust
Mic volume level, click and drag the slider to the desired level.

If a headset is being used, it may also have a volume adjustment.
System Administrator Adjustment

If a wider range of adjustment is needed, the System Administrator can adjust

. - - - L - - 457 PM
the microphone transmit audio level by right-clicking the speaker tool in the L [ NETTIRE ) 12/15/2012
Windows system tray to display the Operating System Volume Mixer.
. For Windows 8 and Windows 7, choose Recording Devices from the drop-down list. On the
Recording tab, double-click the appropriate microphone, and then adjust the slider on the
Levels tab.
. For Windows XP, choose Open Volume Control. In the Master Volume window, choose

Properties from the Options menu. In the Mixer Device list, select the appropriate
microphone, and then click the OK button. Adjust the slider to 100%.
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Select and Unselect Audio Sliders

One or more Radio Controllers can be “Selected” to have their audio received at the “Select” audio level, determined by
the Select volume slider that is located in the Toolbar.

To adjust Select or Unselect volume levels, click and drag the slider to the desired level. Typically, the Select audio
will be set at 100%, and the Unselect audio will be set at a value less than 100%.

There are various ways to adjust incoming volume:
: . $) : .
. For any Radio Controller, click on the speaker tool in the Radio Controller window

header to show the volume slider for this radio channel. Click and drag the slider to the desired
level. Double-click the speaker tool to toggle between mute and un-mute states.

. To adjust “Select” and “Unselect” volume levels, use the Select or Unselect volume sliders on
the Toolbar. Click and drag the slider to the desired level.
. If desk speakers are installed, use the VVolume knob to adjust the speaker volume.

System Administrator Adjustment

If a wider range of adjustment is needed, the System Administrator can adjust the overall speaker volume by right-clicking
the speaker tool in the Windows system tray, then clicking on Playback P
Devices to display the Operating System Volume Mixer. The volume sliders S I P
should normally be set to 100%.

The Toolbar can hold Toolbar Buttons that have been configured by your System Administrator. Toolbar
Buttons can be defined for a wide range of actions and will have custom labels. A few of the more common &
uses for Toolbar Buttons are described below.

Call Selected

A Toolbar Button may be configured to make a call to one or more “Selected” Talk Groups. “Select” a single N
Talk Group by clicking on the header portion of the Radio Controller. “Select” multiple Talk Groups by L)
holding down the Ctrl key on the keyboard, and clicking on the header portion of various Radio Controllers.  caiselectes
(Note that the Radio Controller header will be shaded yellow when “Selected”.) —_—

Custom Action

To make a voice call to the “Selected” channel(s), click and hold the Call Selected Toolbar Button while speaking into
the microphone. If a touch-screen is installed, this can also be done by touching and holding the button on the touch
screen. In addition, a pushbutton on a desk microphone or footswitch may have been configured to activate the “Call
Selected” function.

All Call

A Toolbar Button may be configured to make a call to all radio subscribers in the radio system. To initiate an

All Call to every subscriber in the radio system, click and hold the All Call Toolbar Button while speaking into e
amicrophone or headset. All Call voice messages are queued in memory, and then sent when a channelisclear. .,
This ensures that every subscriber receives the entire message. If a touch-screen is installed, this can also be

done by touching and holding the button on the touch screen.

All Emergency

A Toolbar Button may be configured to activate the emergency tone on each radio in the system.
X

All Emergency
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Quick Map, Archive, and Reports Toolbar Buttons

The Toolbar contains toolbar buttons for Quick Map, Archive, and Reports. Clicking -
one of these buttons will open a window to view information for those functions. The ’? = &
Archive and Reports buttons may be grayed out and unavailable if History Logging has — quickMaz  Awchive  Reports
not been configured. See later in this document for details on these buttons.

Toolbar Buttons for Custom Actions

The Toolbar can hold Toolbar Buttons that have been configured by your System Administrator. Toolbar
Buttons can be configured for a wide range of actions and will have custom labels.

Custom Action

Disk Storage Caution Symbol

RadioPro Dispatch continuously calculates the remaining amount of storage on the hard disk partition specified
by the System Administrator for logging of Voice files, Text Messages, and other radio system events. If less
than two weeks of storage remains on the hard disk partition, a caution symbol will be displayed on the right side  Waming
of the Main Toolbar. If the hard disk partition becomes full, logging will no longer take place. To allow
continued logging, the System Administrator must remove unwanted files, or transfer them to permanent storage media.

Emergency Events

Indicators

When an emergency is initiated from a subscriber, the following indications help to quickly identify the channel and
subscriber:

e An Emergency Notification Tool is placed in the Main Toolbar. This tool can be used to respond =
to the radio user that initiated the emergency. It is also used to clear the emergency.
1001

e Ared emergency icon A is visible in the Subscribers Window, next to the subscriber who
initiated the emergency.

e Anaudio alarm signal is activated.

Operation

The following actions can be used to acknowledge an emergency condition by clicking on the emergency tool being
displayed in the Toolbar:
e PTT - The top portion of the Emergency Notification Tool in the Toolbar can be used asa PTT to
return a private call to the radio user that initiated the emergency. Clicking on this button will A
silence the audio alarm signal for this emergency, and then place a private call to the radio that loo
initiated the emergency.
e  Options — The bottom portion of the Emergency Notification Tool can be used to _
remove the visual and audio indicators for this emergency. AN
1001

Clearing an Emergency State of a Control Station Radio

Remove
The System Administrator can configure the way in which an emergency state is cleared in the Control - M
Station radio. One option will clear the emergency state when Remove is selected from the emergency drop-down list
as shown above.

Another method requires that the Control Station radio be manually reset after an Emergency has been Removed
(cleared). This is accomplished by using the following steps:

1. From the Options menu, choose Manage Devices.

2. Right-click the radio where the emergency state must be cleared, and then choose Restart Radio.

10
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VOICE TAB(S)

Voice tabs hold Radio Controllers and are customized by your System
Administrator to show optional features such as radio programmable
buttons and status information. Radio Controllers can also be customized
with border colors to help organize and highlight certain radio Talk
Groups.

Making a Voice Call to a Talk Group

To initiate a voice call to an entire radio Talk Group, use the PTT button on a Radio /=

Controller Window. Use the PC’s mouse to click and hold the PPT while speaking into a

microphone or headset. If a touch-screen is installed, touch and hold the PTT. In addition, a

PTT pushbutton on a desk microphone or footswitch may have been configured to activate a [ ]
PTT

Public 1: Digital ﬁ

call to a particular Talk Group.

7

Transmit Indicators

When a PTT is activated on a Radio Controller, the following indications are visible: ( Fubiic 1: Digital ) )

e The PTT button background color changes to red. o :;. 10 Public 1

e The Transmitting icon 4 is displayed.
~ -~
e The icon for either a private call ' or group call s displayed. "~ s

e Textis displayed to indicate the Radio ID or Group ID as well as the alias name of the subscriber or group.

PTT

Adjusting Transmit Volume

Use the Mic audio slider on the Toolbar to adjust the transmitted audio. A VU meter is
located next to the Mic audio slider to visually determine the loudness of outgoing
transmissions.

Mic Select Unselect

Patching

If enabled by the System Administrator, the Patch button will be added to the header of the
Radio Controller, enabling the creation of a patch between a pair of Talk Groups. When a patch
is created, transmit and receive voice traffic will be shared by both Talk Groups. In addition,
a voice call placed by the dispatcher to one of the patched Talk Groups will be heard by both
Talk Groups in the patch. b7

Public 1 211"

To create a patch, click the button (until it is highlighted as shown at right) on the two
Radio Controllers that are to be patched together. Patching is limited to a single pair of Talk Groups for the entire
RadioPro system.

If this option is enabled for Radio Controllers on other Dispatch clients, patch status will be displayed on these other
clients.

11
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Receiving a Call

Adjusting the Receive Volume Public 1-Digia

Click the speaker tool in the header portion of the Radio Controller to make an adjustment to
the receive-audio level for a Talk Group. Double-click the speaker tool to switch the audio
level between muted and un-muted. PTT

Receive Indicators

When a call is received, the Radio Controller will indicate the following: Public 1: Digits! )
e The Receiving icon Ui displayed. L :. 1001
-~ -~
e Theicon for either a private call & or group call '« is displayed. PTT

e Textis displayed to indicate the Radio ID or Group ID as well as the alias name
of the subscriber or group.

Connection Status Indicators

Radio Disconnected

When an IP Gateway cannot communicate with the connected Control Station radio, the Radio Public 1: Digita )
Controller background is shaded dark gray, and “Radio Disconnected” is displayed.

Radio Disconnectec

Can’t Connect to Gateway

When the RadioPro Dispatch client cannot communicate with the connected IP Gateway, the Public 1: Digital <)
Radio Controller background is shaded dark gray, and “Can’t connect to Gateway” is displayed.

Can't connect t

12
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GPS MAP TAB(S)

GPS map tabs are configured during installation and occupy a space on the desktop determined by the System
Administrator. They can be configured to be docked to the Main Window using tabs or can be configured to be un-
docked in separate windows. The GPS map tab shown below shows the following features:

Geo-fence — “Polygon 1” outlined in green is a geo-fence that defines the city limits.
Geo-fence — “Route 1” outlined in pink is a geo-fence that defines a route.
Location — A green circle denotes the current location for radio subscriber 9083.

Trail Crumbs — The blue line is the route taken by this subscriber. Hover the mouse over any grey circle
on this route to display the date and time that this subscriber was at this location.

Subscriber Status Bar — Information is displayed at the bottom of the GPS map tab for the selected
subscriber including current speed (or duration of stop), street address, and time since last GPS update.

(0 © &

s (=
< ®
£ Wan @
g e ©

:
{0
® i wee ©

%) S [4] Rossford
% & o Park
. Mansion Hill "
3 ] Phwy
7 i 20)
‘.‘)\(J 18 o
Lt
N z T120)
A - 0 5 '.%@ =2 Woodlawn ]
& o i 5
% iy g £ Licking 4 0 TN g
2014 GotMEYTasp data @2014 Tale Alas, (ryagendise s TefBMatrics Riverside. | @) G Vv &

9083

34 MPH

Subscriber Detalils

Select a subscriber, either by clicking a subscriber icon on the map or by choosing a subscriber in the Subscribers panel.
Note that the current position of the selected subscriber is a green circle to indicate movement, or a red stop sign to indicate
stopped. Notice that Trail Crumbs are shown for this selected subscriber for the last 30 minutes. (This time is configurable
by the System Administrator using the Edit mode.) Hover over any waypoint (grey circle) on a subscriber’s route to show
date, time, and speed at this point.

View detailed information for this subscriber in the Subscriber Status Bar located at the bottom of the map. Information
will include street address, rate of travel (or stopped time), and time since last GPS update.

Click the

Click the

icon to open Google Street View to see the features that a subscriber could see at this location.

icon to copy the information in the Subscriber Status Bar to the Windows Clipboard. This information

may then be pasted into other applications, such as email, text messaging, and Microsoft Office.
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Subscriber Actions

Select a Subscriber

Select a subscriber, either by clicking on an icon on the map or a subscriber in the Subscribers tab.

Make a Private Call

Use the PTT button at the bottom of the Subscribers tab to make a private call to this subscriber.

Send a Text Message

While a subscriber is selected, the Text tab can be used to send a private text message to this selected subscriber.

Toolbar buttons

Subscriber Visibility Button

Click the Visibility button to select which subscribers should be visible on the
selected map. A window will be displayed that looks very similar to the Subscribers
tab. However, the Visible Subscribers tab adds control for visibility. Visibility

may be toggled on and off individually by clicking a subscriber’s visibility “® icon
as shown at right, or as a group by clicking the icon for that group. Three versions of
this symbol will indicate visiblity as indicated below:

ol Visible Subscribers li =g
s

1082 Sam
9 5081 Charli
Symbol | Groups Subscribers i
N N - . 9083 Juan
> All members are | Subscriber is visible (o) 9084 Lence
visible 9085  Laurie
< Some members . M
are visible -
. No members are | Subscriber is not visible
visible

Center (Subscribers on Map) Button

Click the Center @ button to zoom and reposition the map in order to show all visible subscribers on the selected
map.

Follow (the Visible Subscribers) Button

Click the Follow w button to keep the selected subscriber centered in the selected map.

Map Presets Button

Click the top portion of the Map Presets &= button to return the selected map to the indicated preset as configured
by the System Administrator.
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Click the arrow on the lower portion of this button to list other presets that have been configured by the | = |
System Administrator. Click on one of the items in the list to switch the selected map to a new preset. )

Cincinnati Gl

Cincinnati

Denver

Map Type Button

i
Click the Map Type 'J =& button to list Map Types that have been enabled by the System Administrator.

More Map Features
Right-click a point on the GPS map to display the menu shown at right.

L B L AN L

- | Add Place Marker |
8 Clear Place Markers I
L
Quick Reports (9083) L3 1
What's this address?

- Find Address

& 7 Coarl TS

[

Place Markers
e -

Choose Add Place Marker to add a marker to the map. Using the Add Place [ =
Marker window, customize the marker for marker Display Name, Radius, and color. Display Name; My Company
A marker with the chosen parameters will be shown on the GPS map. 4

Choose Clear Place Markers to remove all Place Markers from this GPS map. 1 LI A A

04 |2

Cancel

Quick Reports i =

When a subscriber is selected, choose Quick Reports to show the menu - i oo
options for reports for this subscriber. Available reports include Position i — |

A\ b

Walker Park

- Dayton
Report and Stopped Report. o i L
E Quick Reports (3083)  » Position Report ke
What's this address? Stopped Report l
Find Address i _-Ps“' -
@
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SUBSCRIBERS PANEL

The Subscribers panel lists radio subscriber and subscriber groups. In
addition to the Radio ID, the list may also contain alias names for radio
subscribers.

The Subscribers tab may also contain buttons to perform specific
functions as described below.

Making a Group or Private Call

To initiate a group or private voice call using the Subscribers tab, select a Group or Private =~ &

subscriber, and then click and hold the PTT button at the bottom of this window while speaking | 25! .
into a microphone or headset. Alternatively, if a touch-screen is installed, touch and hold the | [}
PTT button on the screen. | (o)

Subscriber Action Buttons

Additional subscriber actions are available at the bottom of the Subscribers tab, including the following.

GPS Locate

e L Click the GPS Locate button to locate the selected subscriber. After

clicking this button, the Quick Map icon on the Toolbar will display a count- ©
down to locate the radio subscriber. If a GPS response message is received i iy
from the subscriber radio, the Quick Map window will open, and the subscriber will be positioned at the 12

center of the map.

Radio Check
W Click the Radio Check button to determine if a radio is B EG—G——=—=
Lo accessible, and the talk group or channel currently being Wi it
2 B Bt used. A Check Radio window will be displayed to > Weiting on: 1
indicate the subscriber’s availability. —r—

Call Alert

Click the Call Alert button to activate the alert tone on a subscriber radio. The alert tone
will sound on the subscriber radio until the user responds to it.
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Remote Monitor

Click the Remote Monitor button to remotely key-up a subscriber radio. This function
must be enabled in the subscriber radio to allow this function. If function is enabled, the
radio will key-up for a period of time configured in the radio.

Remote Enable and Disable

Click the Remote Disable button to power down a subscriber radio and cause it to be
unable to power up. Click the Remote Enable button to remove this restriction for a
subscriber radio.

Searching for a Subscriber

Click the “" tool near the top of the Subscribers tab to show the Search box. Type "E'fa - ' -
efaul
characters in the Search box for a subscriber radio ID or an alias name. Click the x tool i R =
to clear the typed characters from the Search box. ) tncal
(te) Delores
(te) Tom
(ts2) Wwalt - Truck 12
Sorting the Subscriber List
. . o . = 7 =
Click the == tool near the top of the Subscribers tab to sort the subscriber list numerically ||| "
by Radio ID. Click it again to sort in reverse order. Note that the button changes to |- . 3 :
and indicates a reverse order sort. Oncal
(te) Delores
Click the button to show a list of sorting options; “Sort by ID” and “Sort by Name”. | i

When “Sort by Name” is selected, the sort button changes to 2] ,or "= for reverse sorting.
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GEO-FENCE ALERTS PANEL

One or more Geo-fences may exist in order to check various conditions of radio subscribers. One or more conditions may
exist for each geo-fence. The conditions can apply to All Subscribers or Specific Subscribers. When a Geo-fence
condition is met for a radio subscriber, an event is logged in the database. In addition, Geo-fence conditions that are true
are listed in the Geo-Fence Alerts panel. A typical listing of Geo-fence Alerts is shown below.

Add Note Show on ma

Geo-fence Alert
Speeding
Speeding
Speeding

p # Clear All
Subscriber Geo-fence Time Length
9034 <Everywhere>
9082 <Everywhere> 58s
9085 <Everywhere> 2s

ange ~Eusmnuharas

RECENT HISTORY PANEL

The Recent History panel includes the most recent events of the radio system,
including voice calls, text messages, call alerts, and emergencies. The number
of events displayed in this window can be configured by your System
Administrator, between 1 and 500.

‘ ‘4 E &

To replay audio, click a voice event (indicated by a speaker tool),

and then click the Play  button at the top of this window. If

the Play button *  and the Note button <~ are grayed-out, .
the selected audio event has not been logged to the hard disk = e e —

because History Logging has not been configured. In this case,

the System Administrator must configure History Logging using the Dispatch Settings window,
found in the Options menu.

An alternative method for replaying audio is to double-click a voice event that appears in the Recent
History tab.

Add a note to an event by clicking the - button to open the Note window. Only the last note added
for an event will be displayed in the Recent History window.

The events in the Recent History tab can be sorted by clicking on one of the headings.

MISSED CALLS PANEL

The Missed Calls panel will display a list of incoming private calls that
have not been responded to from the Dispatcher with a return private call.
When a private call is made from the Dispatcher to a subscriber in this list,
the subscriber will be removed from the list.

Additional functions are available from the Missed Calls panel:

To cancel a missed call that is listed, select a subscriber
from the Missed Calls list and then click the Cancel
Missed Call button.

To play the last incoming audio from a subscriber, select a
subscriber from the Missed Calls list and then click the Play Audio button.

To return a private call to a subscriber, select the subscriber from the Missed Calls list and then click the
Call button.
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MESSAGES PANEL

Use the Messages panel to send and receive text messages between this PC and a radio users. It is designed to function

similar to messaging found on a smart mobile device. Two views are available.

Main Message View

Main Message View is the default view and shows the last conversation for each radio subscriber, with the most current

conversation at the top.

A conversation can be started by clicking the @ putton. In the New

Text Message box, choose one or more recipients, and choose an option for
When to send from the drop-down list. Finally, type the message, and then

click the = *™ ' button. The new message will be displayed in the Main
Message View as a conversation. Message status displayed along with the
message include:

e Sending
e Pending
e No acknowledgement

A message that was sent successfully will display the elapsed time from being
sent.

Conversation View

Click one of the conversations on the Main Message View to see the details of a Conversation.
In the Conversation View, all messages with the selected radio or radio group will be displayed,
along with status information for each message.

Use the " button to go back to the Main Message View.

To add a reply to this conversion, type the reply into the Enter Message text box, and then

Send

press the button.
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MENUS

File Menu

Change User B =

Wser  Demo Dispatcher

Click on Change User to open the Login window, and allow another user to log into the
system. il

Open

Configuration files contain customized screen layouts that can be used for different users of the RadioPro Dispatch client
software. Click on Open in the File menu to load a saved configuration file.

Edit

The Edit menu item is used by the System Administrator to customize the operation and screen layout of the RadioPro
Dispatch client software.

Exit

Click on Exit in the File menu to exit the RadioPro Dispatch client.

Options Menu

Manage Devices @

The Manage Devices window displays the status of
connections to radio resources. The settings in this
window can be altered only by the System Administrator.

Status Table

Table headings in the Manage Devices window are
defined as follows: —

Address
IP Address assigned to IP Gateway, and Port Number.

Fiaclo Status Date Time:
01.07.02 12/18/2012 356:37.
Raddi not connected  12/18/2012 346:21,
01.0840 12M8/2012 356:26.
01.07.00 1218/2012 356:35.
01116 12118/2012 256:35.

198.144.49.101:45222 Public % Conneets  Connected 5110

Name
Name assigned to IP Gateway.

Gateway Status
Indicates “Connected” and firmware version of IP Gateway, or “Not Connected”.

Radio Status
Indicates firmware version of Radio if connected, or “Not Connected”.

Date/ Time
Date and Time being used by IP Gateway.

Record Option
When checked, allows logging of audio to the database.

Audio Option
When checked, allows audio to be heard for this IP Gateway.

Text Option
When checked, this option allows text messaging for this IP Gateway.

20



RadioPro Dispatch User Guide

Actions
The following actions are available by right-clicking on an entry in the Status Table.

o Restart Radio will restart the Control Station radio connected to the selected IP Gateway

o Restart Gateway will restart the selected IP Gateway. The Gateway Status will be indicated as “Not
Connected” for approximately two minutes. Following this period of restarting, verify that the IP
Gateway and Radio indicate a proper connection status.

System Problems Box

The System Problems box at the bottom of the window will describe current system faults, such as unconnected Radio
Resources and License limits.

Audio Presets

Audio Presets may be configured by the System Administrator for various audio devices including speakers,
microphones, and headsets. A “default” preset uses the PCs default selection for microphone and speakers. All configured
Audio Presets will be listed, with the selected preset indicated with a check mark.

Update License

When not in Edit mode, the Update License window can be viewed, but cannot be [Eresete—_—_—==
altered. It will show the USB Key ID #, and licensed options. Hasp Key I 1070

To export the license file for archiving to another location, click the Export button, and
then choose a file name and location.

ProVUi GPS. Yes

Export

Contacts

Click on Contacts from the Options menu to open the Subscriber Contacts window. This window can be used to
add, delete, or edit alias names and other information related to a Radio ID. It can also be used to create groups of radio
subscribers for better organization within the Subscribers window. This information will be displayed in the
Subscribers tab.

Editing the Contacts List

Use the right side of the Subscriber Contacts window to make

changes to contacts. Click the Ly button to add a contact to the

13777215
Frngy

<o
=] Puste s
[wat-tusk e chuor
7] Moy Tk 14 i
[clroby Tuskzs chutor

B Sam- Tuck 41 <hulo>

E[ Matt- Truck 43  chulos

E[ Delares oy

1001 Digtsl Private Ei Tom <huta

-

Table headings in this window are defined as follows: ——
ID

10

list. Click the *» button to delete a contact from the list. This
information will be displayed in the Subscribers tab. i

Subscriber Radio ID (digital channel) or MDC code (analog channel)

Type
Subscriber type: Digital Group, Digital Private, MDC Group (analog channel), or MDC Private (analog
channel).

Alias
Alias name associated with a Subscriber Radio ID

Assigned Channel
“Automatic” (default normal mode) allows the system to dynamically assign an IP address of a Radio
Resource. Alternately, a Radio Resource may be permanently assigned to this Subscriber Radio ID using
an IP Address and Port Number.
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Managing Groups

Use the left side of the Subscriber Contacts window to make

changes to Groups. Click the * button to add a new Group.
2 D

Click the x button to delete a Group. Click the '* 4 button to

edit a group’s name. This information will be displayed in the

Subscribers tab.

nca <Buo>
[ puste <Auter
[z wal Tk 12 <Buo>
[2hany Tk 14 <o
=] oy Tk 28 <Buo>
=] som-Truck <Auler
7] watt-Truck 43 <Buto>

E[ Delares <Auta>
Ei Tom

Dighal Gioup
igial
i

slissTable csv Save Cancel

Saving the Contacts List
Click the Save button to save changes to the Contacts and Groups. Changes will be saved to a file named:

aliasTable.csv

This CSV (Comma Separated Values) file can be viewed and edited

directly using Microsoft Excel by using the link at the bottom left

corner of the Subscriber Contacts window. When saving this S——

file from Microsoft Excel, be certain to save it as a CSV file. Sjji o

I - i e
3083 BTDW Truck 23 £ chuttoy
9084 E[Sam Truck 41 :<Autu>
3085 EI Matt - Truck 43 £ chutt>
257 B Delores .<Auln>
1001 Digital Private Ei Tom :<Aum>
Help Menu
About

Click on About in the Help menu to display Part Number and Version of the RadioPro Dispatch client.

Remote Support

If difficulties are experienced with RadioPro Dispatch and the console PC has Internet access, use this option to assist our
Technical Support department in remotely logging into the PC.

Logs

This feature is used by CTI personnel only.

ARS / GPS Events

This feature is used by CTI personnel only.
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Quick MaP

e
e

Click the Quick Map button
shown below.

on the Toolbar to open the Quick Map GPS window. An example Quick Map is

@ QuickMep [ = e )|
) = 7 F A i
(+ = ' 9 h ¥ &L
A 5 § B 4 — Quick Map
ZoomIn Zoom Qut C’ngf Map Cmtmﬂ'-\ GPS Locate Text PTT Follow - T00| Bar
*, Helohon St i) e e St Bemard (7)==t
Y s S b i | Buttercup L
E 5 ¥ @ . oy, £ Valley Preserve € Ross Ay,
‘ & et Ra o Eypa R StBemard o
ek Breigstown z Sawsy Park +
North, 7 ¥ L3 D i Paddock
Uoe Rock 51 £ E Mitohel ave Hils
Selected Bitpso |
. North ik North
Subscriber ™ o &l & MiSiom Avondale
Cumminsville
*
East
Westwood puestE0g Lt g._?b
'
Mo, Millvale i, 8 tavy 4
2 "Beorn
£ " gy, Burnet Avondale
§ . | iCamp Woods
7 % Washington z 4 ]
‘,, 3 %, iR 9083) , Comyville
Woodiand y 5, English oppie 6t 1| &
Golf Course - Woods i %,
2 £
o 2 z =
! = The Heigh i
H Covedal Fairmount BN e
= We: S Ave = Inwood Park g -
Unselected L 5 T R Koot |~ Geo-fence
S b . b Y R o Famont ot
upscriper it Cleves Warsaw Pike B = & & =] Py Jrhium
West Gians Iy i,
%, id Prie Hil A A (and)
T 00 o /IRy,
iy z o - Warsaw v (2] o
4 Feamg T East Gest 5t G
' £ Price Hill s Weth
90k angle - biap data GEO14 Tele A, Imagery GRU14 TerrabdBiios 0¥ R & g :
9081
e |
38 MPH

Selected Subscriber

One subscriber may be “Selected” by clicking on its label. When a subscriber is “Selected”, its label (including radio ID
or alias name) will be emphasized, and the following actions are available:
Make a Private call to the subscriber. (See PTT Tool below.)

[ ]

e Send a Private Text Message to the subscriber/ (See Text Messaging Tool below.)

e View the Snap-to-Road route traveled by the subscriber.

o View Time-stamp at a location and Speed of Subscriber by hovering over any Trail Crumb.
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The Toolbar for the GPS Window contains tools for Zooming, Map Type, Map Presets, GPS Locate, Text Messaging,

Toolbar
and PTT.
Zoom Tools
Use the Zoom In and Zoom Out tools, or
optionally, use the mouse scroll wheel for
zooming.

Map Type Tool

Your System Administrator may have configured
optional Map Types to be available. Click this tool
to display these optional Map Types including
Roads, Satellite, and Hybrid.

Map Presets Tool

Your System Administrator may have configured
optional Map Presets in order to quickly jump to
various geographic locations with a predetermined

zoom setting. Multiple Map Presets may be configured.

GPS Locate Tool

This tool duplicates the function of the GPS
Locate button located in the Subscribers tab.
Before clicking this tool, select a Subscriber from

N =) ¥ A A,
& Q) I*i fon e, & g
5 b3 = ] 2
Zoom In Zoom Qul Google Map Cincinnati GPS Locate Text 1T Follow
&) Q fa Al © gk
A Y b 3 ] E
Zoomin  ZoomOut Cincinnati GPS Locate Text PTT Follow
- . - ’ A
+) (= i "-" & &‘1
-2 N ',\-.Lg» 180 L_,J
Zoom In Zoom Out Google Map GPS Locate Text PTT Follow
- . -
+) (= i &‘1
Zoom In Zoom Out Google Map PT Follow

| —
the Subscriber List. Click the GPS Locate button to locate the selected subscriber. After clicking this button, the
GPS Locate tool will change to the Locating tool, with information relating to the selected subscriber. When the
subscriber is located, the GPS window will open, and the subscriber will be positioned at the center of the GPS map.

Text Messaging Tool

Use this tool to send a text message to the
subscriber selected on either the GPS Map
Window, or in the Subscribers tab. After
clicking this tool, the Send Text Message
window will be displayed as shown at right.

PTT Tool

Use thistool to make a private call to the subscriber
selected on either the GPS Map Window, or in
the Subscribers tab. Click and hold this tool for
the duration of the call.

. . z .
o) G e A a*
A ~y '\ B 8 g
Zoom In Zoom Qut Google Map Cincinnati 1T Follow
Send Text Message
Send text to 9082 Nancy - Truck 14
|
Cancel Send
. . - . ’
+) (= rj Py Adp @m
A ~y '\ B a D/ g
Zoom In Zoom Qut Cincinnati GPS Locate Tex 1T Follow

Google Msp
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ARCHIVE VIEWER

The Archive Viewer may be opened using either of the following methods:

tool on the Toolbar.

folder.
From the folder: C:\Program Files

copy the file named: ArchiveViewer.exe
to a PC that requires access to the RadioPro database.

To open the embedded version of the Archive Viewer from RadioPro Dispatch client, click the Archive

During installation of RadioPro Dispatch, the stand-alone ArchiveViewer.exe is copied to the installation

(x86)\RadioPro\

The Archive Viewer has major sections indicated below; Search Filters, Search Results, Event Detail, and Page

Navigation Bar.

~ Archive History - D - - U — = &
p & Any Terms - Eal Al
Start Time 4 ; =2 1 A
All Terms. | / L:.J x M 3 E]
. End Time
Search Filters Today Motes Only | Audio Emergency Alert | GPS | Text GeoFence
L Q | | Search
s Records Found: 2264
Tuesday, December 11, 2012
Description LMESEM o G atewray Channel Fone Ch/Zn -
& 12:004M Puliz 1
SearCh ReSU|tS “" E Maintenance - Judy (4084)  (39.04, -84.67). 50.00 mph 12:00 &M Fublic 1 Di. Zone 2 1A I
A% [§ Trafic (3085) (38.16, -8452), 25.00 mph 12004M  Public 1 Di. Zone2 14
A% [ security 1 (3081) (38.17, -84.45), 40.00 mph 12004M  Public 1 Di. Zone2 14
\_ y ecur . 2 i 12004M  Public 1 Di. Zone?2 11 =
A 5 2343082 39.03, -84.48), 60.00 raph "
~ e fl
o ) o] 5
k-— & k* "% Google Satellite Cincinnati
© Wiberly St Oyer.The-Rhine % P Miadams Wb s ||
. WestEnd | < Tims e )| Peand SRS s
& 3 : L &
Event Detail a 3 . 2(3083 Mantenance - Walt & 5
[17] Ezzard Chartes 1 ¢ 3 ’;éz MtAdsms .o Bellewue
o io P & Beach Park
o @ & ; 2 goew e & go b
esf St (27 ] {
N\ » 5 @ oSt ® f X (8)  Bellevus
P ‘ f
: : << 2 3 4 5 7 & ) @ 11 12 13 14 15 15 =2
Page Navigation Bar [ 1 : 391 2 13 5 16

Search Filters Area

The Search Filters Area of the Archive Viewer Window allows very flexible searching of the database and display of

the search results using the features described below.

Quick Filter Bar

The Quick Filter Bar contains tools to easily find archive events based on day, time, user, radio channel, or event type.

Preset Time Intervals

The Preset Time Intervals allow various
selections such as “Today”, “Yesterday”,
“This Week”, “Last Week” and others. To
specify a Preset Time Interval, click the

button, and then choose an interval from the drop-down list

Audio|Emergency | Alert | GPS | Text | Geo Fence

% |1

All Terms:

Notes Cnly

Search
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Custom Time Interval

specified for time periods that are not in the
Preset Time Intervals list. To specify a

Custom Start Time and End Timemaybe [

Custom Time Interval, click the

Event Type(s)

button, choose Custom Interval from the drop-down list, and then complete the Start Time and End Time fields.
One or more Event Types may be selected
as part of the search criteria. Click the All I

[ @ = [ 2 gl x [1hel ) B ] ‘
button to quickly select all event types. Ifa
search is performed with no Event Type selected, the search will include all Event Types.

Click the Notes Only button to search only for events that have Notes attached to them. Notes are attached to an event

by clicking the Note button - on the Recent History tab.

Custom Search Criteria
o

Today

Use the Custom Search Criteria box to enter

specific details about the events to be found. I
Searchable items include Gateway name, |
Channel name, Zone name, Alias name, and Alias ID number. The following are some guidelines for search criteria:

e Separate each search detail with a space.

e Any Terms vs. All Terms: If Any Terms is selected, searching for “Bob North” will return all results
where either “Bob” or “North” is found. If All Terms is selected, searching for “Bob North” will
return all results where “Bob” and “North” is found in a single record.

e Search criteria are NOT case sensitive. For example, a search for “North” is the same as searching for
“NORTH?” or for “NoRtH”.

e Wild card character (*): The wild card character can be used to search for zero or more characters after
the end of a search item (and only at the end). Correct search criteria include “Bob™, or “B*”. Incorrect
search criteria include “B*b”, or “*ob”.

e Double quotes (*“ *“): Searching for a phrase using double quotes, such as the Gateway name ”Fire
North” (including the space between the two words), will find the entire phrase within the double quotes.

e Special characters: Any special characters used in naming will be logged to the database. However,
special characters cannot be used as search criteria.

Search Examples

Correct search criteria to locate Gateway name Fire North include:
o Fire
e North
o Fire North (space between Fire and North)
o North Fire (space between North and Fire)
e “Fire” “North”
° F*
e F* N* (space between F* and N*)
e  “fire north”

search criteria include: , , , ,
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Search Button

Click the Search button to perform a | @ e gl ox (1) ) m
search for all parameters selected in the Ny o gy A | 67 | et G e
Search Filter Area.

Search Results Area
The Search Results Area will display the | Tuesday, December 11,2012

records that match the search criteria
specified in the Search Filters Area. The
various sections of the Search Results Area
are described below.

Records Found

Ch/Zn

) 12008M
AR [J Maintenance - Judy (3084)  (39.04, 84E1), 50.00 mph 1200 4M
44 [ Trafic (3085) (39.16. -84 52). 26.00 mph 120044
A& 3 secury 1 @061) (39.17, -84.45). 40.00 mph 12004M
4R [B Securiy 234(9082) (3903 -84.48), 60.00 mph 1200AM

This parameter displays the number of Records Found that match the search criteria.

Search Target Date

This parameter displays the Date for the Records displayed.

Records Found List

This section lists the Records Found that match the search criteria.
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Public: 1 Di.

Public: 1 Di.

Public 1 Di.

Public: 1 Di.

Zone 2

Zone 2

Zone 2

Zone 2

11 |
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Event Detail Area

The Event Detail Area lists specifics about the event that is selected in the Search Results Area, and will change depending
if the selected event is a Voice Recording, Subscriber GPS Location, Text Message, or Geo-fence Event.

Voice Recording Detail

If the selected event is a Voice Recording, > 0010
the Voice Play Tool will be displayed.

Click the Play Button b to begin the playback of the selected VVoice Recording. Click the Speaker Button " 1o
display the Audio Playback Level slider.

Subscriber GPS Location Detalil

If the selected event is a Subscriber GPS @ e ] A '
Location, a Toolbar will include Zoom S ma 7
Tools, Map Type Tool, and Map Presets b i T =
Tool. In addition, a map will display =gl - iy pE= AN
subscriber details and location for the - S B A9

. st & £ ey const @ ¥ (@ petewse
archived event. F :

Page Navigation Area
) < == .

Click or to view :
the previous or next page of events, or U = ' 3 O W e -

click on a number to view that page.
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WHATIF . ..

What if One Radio Controller is Grayed-out?
Example Screenshot

File Options Show Help.

& X

AllCall Al Emergency

Great Lakes Southwe | (1%t * ____— OneRadio Controller
- | is grayed-out and
not connected

Public 4 LTR ))

(P

Time. Gateway Src user ernel  Detais Lasthote

Significance

When one Radio Controller is darkened as indicated above, it could mean any of the following:

e The network connection between the PC and the IP Gateway has been lost, indicated by “Can’t connect to
Gateway”.

e The IP Gateway is either turned off or is in the process of rebooting.
e The Control Station radio is either disconnected from the IP Gateway, is turned off, or is in the process of
rebooting, indicated by “Radio Disconnected”.
Details
Further detail about the connection to an IP Gateway is available by using the information in the Manage Devices
window as follows:
o From the Options menu, choose Manage Devices.

o Inthe Manage Devices window shown below, the Gateway Status will be indicated either as
“ 7 or “Not Connected”. In addition, the Ratio Status will be indicated as either
“Connected” when its version is displayed, or “Radio not connected”.

| e ad |

Address Mame Gateway Statug Radio Status Date Time

198.144.49.102:48222  Public 4 LTR Connected - 5.1.10 01.07.02 12M9/2012 13702,

1000120045222 Toms River Connected -5.1.9 Radio not connected  12419/2012 1:26:48.

198.144.43.99.48222  Public 1: Digital Connected - 5.1.10 01.08.10 12M19/202 1:36:50.

198.144.49.100:48222  Public Z Analog Connected - 5.1.10 01.07.00 12M9/2012 13702,

198.144.43101:48222  Public 3 Connects Connected - 5.1.10 011116 12M39/2012 1:37:02.

System Problems

Description

1 radios not connected to gateway.

Ore or more gateways notin spnc with time server,

H a“" » H H H Ly H 14

Gateway Status is and Radio Version is “Radio not connected

e Verify that the Control Station radio is powered on.
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Verify that the Control Station radio is physically connected to the IP Gateway using the supplied cable.

Verify that a programming cable is NOT connected to the front mic connector of the Control Station radio.
If a programming cable is connected to the front mic connector, remove it, and then reboot the radio.

Gateway Status is “Not Connected” and Radio Version is “Radio not connected”
o Verify that power is connected to the IP Gateway.
o Verify that the blue Power light on the front of the IP Gateway is illuminated.

o Verify that the IP Gateway is accessible to the RadioPro software by using the Ping function from a
Windows command prompt.

e Look into the left-side vent holes of the IP Gateway and observe the red LED:
o Anon-blinking LED indicates that the IP Gateway has completed its rebooting sequence and is
running normally.

o Ablinking LED indicates that the IP Gateway is rebooting. Rebooting should be completed within 2

minutes. If rebooting is not completed within 2 minutes, return unit to CTI Products for repair.

What if All Radio Controllers are Grayed-out?
Example Screenshot

S TorboVUi Dispatch - Deraul

& X

All Radio Controllers
— are grayed-out and
not connected

Pubic&LTR )

Chamnel  Detail

© TSSEZPM 1219/2012 TX Group Callta (10 Public 1)
@ LIITPM 121972012

2
re2 T Group Callta (10 Public 1)

Significance

When all Radio Controllers are darkened as indicated above, it could mean any of the following:
e  Power has been removed from all IP Gateways.

e The network connection between the PC and the IP Gateways has been lost.

e A USB Hardware Key is not installed in the PC.

e A Software License that matches the USB Hardware Key is not installed.
Corrective Actions

Power has been removed from IP Gateways

e Verify that the IP Gateways have power and are powered on.
Network Connection has been Lost
[ ]

Verify that the IP Gateways are accessible to the RadioPro software by using the Ping function from a
Windows command prompt.
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e Verify that the IP Gateway is accessible to the RadioPro software by using the ICU.exe utility.

A USB Hardware Key is not installed
o Verify that the USB Hardware Key is installed.
e Remove the USB Hardware Key and verify that the Windows alert tone for USB disconnection is heard.
e Re-insert the USB Hardware Key and verify that the Windows alert tone for USB connection is heard.

Software License is not installed or is incorrect
e Verify that a correct Software License is installed by using the following steps:
o From the Options menu, choose Update License.

o Inthe Update License window, verify that the USB Key Id matches the serial number engraved on
the USB Hardware Key.

o Inthe Update License window, verify that Connections is correct for the number of Radio
Controllers.

What if the Transmit Error Window is displayed?

Example Screenshot

Transmit Error T— S
8 Microphene (Microphone (Buddy DesktopMic 7G) not available.
0K
Significance

The above window may be displayed when a PTT button is activated, and if the microphone selected for transmitting is
not connected. This can occur if a microphone has been disconnected from the Dispatch PC, or if a microphone has been
replaced by another microphone.

Corrective Actions

Determine if a microphone is connected
o Determine if the Windows operating system recognizes a microphone connected to the PC by using the
following steps:
o Inthe Windows System Tray located at the lower-right corner of the Windows screen, right-click on

the m tool, and then choose Recording devices. The following Sound Recording properties

window will be displayed.
-# Sound Lihj

[ playback | Recording | sounds | Communications |

Select a recording device below to madify its settings:

Microphone

Microphone

L 4

-y

L 4

-‘g Def:
2
> o

[ ok [ cancal

If the microphone does not appear in the above window, ensure that it is connected to the PC.

If the microphone appears in the above window, speak into the microphone and notice the response of
the sound level indicator. The Sound Level Indicator should reach at least 50% with normal voice
volume.
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Check Microphone Configuration in RadioPro Dispatch Client

User Guide

With the microphone connected, it is possible that the configuration in the RadioPro Dispatch client is

incorrect. Use the following steps to verify correct configuration:

o

o

From the Options menu, choose Audio Presets, and then verify that the correct preset is selected.

Retest the microphone function in RadioPro Dispatch. If needed, ask the System Administrator to
continue with the remaining steps.

From the File menu, choose Edit.

From the Options menu, choose Audio Presets, and then choose Config.

Click on the Devices tab to display the following window.
- et S|

ol Audio Configuration

AudicSettings cfg

General

Devices

Levels

@ Save Settings

Presets

Preset Name

Mic In

Select Out

Unselect Out

Intercom Out

CTl Jackbox
Buddy Mini Deskiop

Buddy DesktopMic | .
A Q
‘ hd

Amigo Cobra

| Microphone (Amigo Cabra). = |

| Microsoft Sound Mapper = | | Both -
[ Microsoft Sund Mapper = | [Both -]
Microsct Sound Mapper = | [Both |

In the Devices tab shown above, verify that the Mic In parameter is correct for the Preset being

examined.

Click Save Settings to exit the Audio Configuration window.
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FEATURE AVAILABILITY

Motorola MOTOTRBO Systems

Depending on MOTOTRBO System Type, some features may not be available. Use the following table to determine if
a feature discussed in this document is not available.

Feature

Voice Dispatch

Text
Messaging

GPS Mapping

ARS

Private Call

Remote
Monitor
Remote
Enable/Disable

Kenwood NEXEDGE Systems

Depending on NEXEDGE System Type, some features may not be available. Use the following table to determine if a
feature discussed in this document is available.

Feature

Voice Dispatch

Text Messaging

GPS Mapping

Status Updates

: : Not Currently Not Currently
Selective Call

elective L-afling Supported Supported
Remote Monitor
Remote
Enable/Disable
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INDEX
Export, 21
A Update, 21, 31
USB Key, 21
Add Note Button, 9, 17, 18, 26 Login, 7,20
Alias Name, 21 Logs, 22
Alias Table, 22
All-Call Tool Button, 9 M
All-Emergency Button, 9
Archive Map, 25 Manage Devices Window, 10, 20, 29
Archive Viewer Window, 25 Map Presets Tool Button, 24, 28
Assigned Channel, 21 Map Type Tool Button, 24, 28
Audio Preset, 8, 21, 32 Menu
File, 20
C Help, 22
Options, 8, 20
Call Alert Button, 16
Call Select Tool Button, 9 (o)
Change User, 20
Connected, 20, 21, 29, 30 Overview, 6
Control Station Radio, 6, 10
CSV Format (comma separated values), 22 P

Custom Time Interval, 26
Page Navigation Bar, 25

D Patch, 11
Play Button, 28
Devices Tab, 32 Preset Time Interval, 25, 26
Dispatch Settings, 18 Private Call, 23
PTT Tool Button, 23, 24
E
Emergency, 9, 10 Q
Event Types, 26 Quick Filter Bar, 25
Notes Only, 26
R
G
Radio Check Button, 16
Geo-fence, 18, 28 Radio Controller, 8, 9, 11, 12, 29, 30, 31
Geo-fences, 28 Radio Controller tab, 7
GPS Locate Tool Button, 16, 24 Radio Disconnected, 12, 29
GPS Mapping, 23, 24 Radio ID, 11, 12,17, 21
Groups, 6, 9, 11, 21, 22 Recent History tab, 7, 18, 26
Records Found, 27
| Remote Disable Button, 17
Remote Enable Button, 17
IP Gateway, 6, 12, 20, 21, 29, 30, 31 Remote Monitor Button, 17
Reports, 10
K Restart Gateway, 21
Restart Radio, 10, 21
Key
USB Hardware, 30, 31 S
L Search Target Date, 27
Show Console, 22
Levels Tab, 8 Snap-to-Road Route, 23
License Sorting, 17
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Subscriber Contacts, 21, 22
Subscriber List Sub-folder, 17, 24
Subscribers tab, 16

T

Text Messaging, 6, 7, 24

Tool Bar, 8, 9, 10, 11, 23, 24, 25, 26, 28
Tool Buttons, custom, 9, 10

Toolbar, 8, 9, 10, 11, 23, 24, 25, 26, 28
Toolbar Buttons, custom, 9, 10
Transmit Error, 31

Version, 1, 22, 29, 30

Virtual Private Network, 6

Voice and Event Logging, 6, 10, 18
Volume Adjustments

35

Receive, 12
Select Receive, 8, 9
Unselect Receive, 8, 9

W
Warning
Disk Storage Caution, 10
X
XPR4550, 10
Z
Zoom, 24, 28



